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[bookmark: _Ref506478444]1. Introduction
Optical trapping began as a proposed method for atomic trapping and laser-cooling, but evolved into a tremendously powerful tool in biological physics. Applications for optical traps range from manipulating single bacterial cells, to measuring the forces generated by singular motor proteins. Most experiments involving optical traps will require the determination of trap stiffness, which is the effective spring constant experienced by a trapped bead displaced from equilibrium. Since the factors involved in determining the stiffness of optical traps are often complicated and theories for calculation are not entirely accurate, the stiffness should be measured empirically each time a parameter is altered. The goal of this lab is to measure the stiffness of the optical trap through multiple methods. 
2. Theory
2.1 – Background on Optical Tweezers 
The optical tweezers apparatus is used to hold microscopic particles stable during examination.  This is done through the use of a highly-focused laser beam.  The photons comprising the beam each carry momentum and therefore exert force.  By aligning the laser beam, the photons are focused and the resulting electric field gradient is strong enough to hold a dielectric particle or bead in positon.  
Optical traps, originally designed to trap atoms and study laser cooling, now have ample use in the biological sciences.  Any biological particle to be studied can be attached to a small dielectric bead [3]. This bead will become attracted to the photon generated electric field and remain in this positon for observation.  This process is used to investigate, examine, and compare the various intrinsic aspects of small particles, such as cell motility and optical intensity.  The most common use of optical trapping involves the study of cell stiffness.  Once the light force exerted upon the trapped bead and the bead displacement is measured, this information can be used to determine the force exerted by the trapped cell.  
2.2 – Optical Trapping Theory
2.2.1 – Forces Affecting Trapped Particles 
Each photon in a laser beam carries momentum and can exert force.   When the beam of the laser is focused, through a microscopic objective, each photon will exert force in a single direction.  This combined focus, which provides enough force to trap and move small particles, is manipulated and applied using the optical tweezers apparatus.  There are two types of forces, the gradient and scattering force, which exert themselves on a particle and trap it in the path of the laser beam [3].  
The gradient force is a result of the electric field gradient present when a laser beam is focused and photons are aligned.  This electric field is strongest at the narrowest part of a focused beam, the beam waist.  The dielectric particles to be studied in the optical trap become attracted to the electric field gradient of the beam waist.  
The second force affecting dielectric particle movement, the scattering force, is due to the change in momentum experienced by photons traveling in the direction of beam propagation.  This force slightly displaces the trapped particle downstream from its original positon at the center of the beam waist.  
As a result of the combination of both the scattering and gradient force, a particle will be trapped in the optical tweezers apparatus slightly downstream of the laser beam waist [3].  The lateral displacement from the center of the beam is dependent on the strength of the scattering force and the stiffness of the optical trap.  The optical trap stiffness can be thought of as the effective spring constant, k, of Hooke’s Law [4].  Trapping only occurs when the gradient force is stronger than the scattering force.
2.2.2 – Modeling Optical Trapping Forces 
Predictions on the affect optical forces have on trapped beads are directly dependent on the diameter of the bead relative to the wavelength of the incident laser.  The classic ray optics model is sufficient to explain how forces trap and displace bead particles only when the radius of the particle is a great deal larger than the laser wavelength.  Once the diameter of a bead to be trapped is much smaller than the incident light wavelength, then the particle can be treated as an electric dipole and the electric dipole approximation can then be used to predict force interactions.  
The Ray Optics Model
When the diameter of the trapped particle is far greater than the wavelength of the incident laser, the classic ray optics model of ray refraction can be used to describe the affect scattering forces have on trapped particles and the resulting gradient forces which withstand the scattering effects and keep the particle trapped just downstream of the beam center.  
As emitted photons travel the path of the laser, they carry momentum.  The momentum associated with each photon changes as it interacts with the trapped dielectric bead. This is because light particles colliding with the glass bead are refracted as they rebound off of the particle.  This refraction results in a change of photon direction and therefore an alteration in the photon momentum.  This change in momentum will cause a force to be exerted on the photon and, as a result of Newton’s Third Law, a force of equal magnitude will also be exerted upon the trapped bead.  
The laser beam used to operate the optical tweezers apparatus maintains a Gaussian profile.  This means that the affect each photon has on the trapped bead is dependent upon its distance from the bead.  As a result, the photons near the beam waist and trapped bead, which exert an attracting force and pull the bead towards the center of the beam, will have a more intense affect than those photons further from the trapped bead attempting to displace the particle from the beam waist [5].  When these distant scattering forces attempt to move the trapped particle to the left or right of the beam center, the high intensity attractive forces overcome this displacement and maintain bead positon, as seen in Figure 1 [4].  These high intensity forces restoring the radial positon of trapped particles are referred to as the gradient force [4].  
[image: ]
Figure 1: Any attempts to radially displace the trapped bead from the beam waist are overcome by the higher intensity attractive forces closer to the bead.  [4]
Now, once the gradient forces have returned the bead positon to the center of the trap, then all refracted photon rays will be symmetric about the bead, leading to a net momentum of zero.  Without a change in momentum, there will be no forces pulling the bead from the center of the trap, and so it will remain in this lateral positon.  Thus, without a lateral net force, only the scattering forces in the axial direction of the beam path will be able to influence bead movement.  It is these scattering forces which cause the radially centered bead to undergo lateral displacement and be trapped slightly downstream of the beam waist, as seen in figure 2 [5].  
[image: ]
Figure 2: Once the trapped particle is centered radially, scattering forces in the lateral direction cause the bead to be displaced slightly downstream of the beam waist. [4]
The Electric Dipole Model 
Once the radius of the particle to be trapped is sufficiently less than the wavelength of the incident laser beams, then the electrical dipole model can be used to approximate the photon and particle interactions.  Because the trapped bead is so much smaller than the laser wavelength, it can be thought of as a point dipole in the photon electromagnetic field.  
The force acting on a single point charge placed in a magnetic field is called a Lorentz force [6] and can be mathematically described through the equation: 
[image: ]                                                                                                        
                                                                                                                     	(1) 
where:	F is the force [N]
E is the electric field [V/m] 
B is the magnetic field [T]
p is the dipole moment, p= qd
q is the particle electric charge [C]
and 	d is the distance between charges [m].
Now, because we assume that the trapped point charge is linear, we can eliminate the dipole polarization from equation (1) through the use of the polarizability, α, where p= αΕ.  Equation (1) can be then be rearranged into the form of:
                                                                                                                   [image: ]	  (2) Which is simplified to: 
	[image: ]	   	      (3)
The last term on the right-hand side of equation (3) is the time derivative of the Poynting vector, which represents the power flux through an electromagnetic field.  During the optical tweezers experiment, the sampling frequencies are much shorter than the frequency of the laser beam, ~ 1014 Hz, and so the power of the laser will be constant [7].  Constant power will lead to a zero value of the time derivative of the Poynting vector and so this term can be removed from the equation.  The force acting on the electric dipole can then be represented with the equation: 
	[image: ]	    	 (4)
Because the Ε2 term in equation (4) represents the electromagnetic intensity of the photons, the 	 strongest light forces acting on the particle will be those with the highest intensity.  As the peak photon intensity occurs at the center of the beam waist, the forces acting on the bead to be studied will draw it to this positon.  These forces are then of gradient type, as they attract particles to the center of the beam.  
As in the ray optics approximation, once the gradient forces have radially centered the beam, only axial displacement due to scattering forces can now occur.   These scattering forces, represented by the Rayleigh approximation: 
[image: ]                    (5)
once again displace the trapped bead slightly downstream of the beam waist [6].  
2.3 – Applications of Optical Tweezers
Although the optical tweezers trap was initially designed as an atom trap, it has found a wide range of applications in physics, chemistry and biology. The first application of optical trapping in biology was on the trapping of viruses and bacteria [L1]. With manipulation of the laser wavelength being used, it was eventually possible to trap bacteria cells without damaging them. From here, researchers proceeded to trap a variety of cells, including pigmented red blood cells, green algae, diatoms, amoebas, and other protozoans [L2]. Further work used scallion cells to create an “artificial cytoplasmic filament” by using the trap to pull a filament from the surface of the nucleus of the cell into the central vacuole of the cell, as shown in Fig. 3 [L3]. Optical tweezers have more recently been used to study the viscoelastic behavior of single strands of polymeric molecules, such as DNA [L4]. 
Optical trapping has also been widely used in the fields of physics and chemistry. Optically induced torques and rotations of micromachined μm-sized anisotropic particles held in a tweezers trap have been observed [L5]. It has also been shown that small metallic Rayleigh particles have polarizabilities larger than dielectric particles and can be trapped in tweezers [L6]. In studies pertaining to colloidal science, direct measurements using tweezers showed that an attractive force can exist between like-charged particles in a colloidal suspension near a surface, contrary to theory. Based on this work, metastable colloidal crystals were created [L7].
Further references regarding applications of optical trapping can be found in the Papers section of 
Appendix I. In particular, Ashkin provides a thorough history of optical trapping from 1970-2000 in History of Optical Trapping and Manipulation of Small-Neutral Particle, Atoms, and Molecules. Another useful resource is the guide to the literature on optical tweezers provided in Resource Letter: LBOT-1: Laser-based optical tweezers. 
 

Figure 3: Artificial cytoplasmic filaments in a scallion cell. Laser trap is initially located at point A on the nucleus (N), and is moved to B, pulling the filament AB [10]. 
3. Apparatus
3.1 – Important Safety Rules
1) The optical fibres used to transport the output of the laser source to the rest of the apparatus are extremely delicate.  Do not remove the protective plastic enclosure surrounding these fibres. 
2) After exiting the FibrePort Collimator, the laser beam is concentrated and extremely dangerous. To prevent retinal damage, the laser is encased in an opaque enclosure.  If access into the enclosure is required, contact the lab TA's for assistance. Under no circumstances should students remove this safety enclosure with express permission and assistance from a lab coordinator. 
3.2 General Description of the Optical Trapping Apparatus
The optical trapping apparatus and a schematic of the components of the apparatus are shown in Fig. 4a and 4b, respectively. 
[image: ]
Figure 4a: Optical Tweezer Apparatus.
 
[image: ]
Figure 4b: Schematic of Optical Tweezer Apparatus [8]
Table 1 provides a brief description of each major component comprising the optical trapping system. Detailed instructions regarding operation of these components can be found in Section  6. Experimental Procedure of this write-up and in the Thorlab manuals listed in the Appendix and on the OPT webpage. 
Table 1: General Description of Optical Trapping Apparatus 
	Component Name
	Object Number in the Scheme (Fig. 4b)
	Description

	Laser Diode Controller
	1
	The 330mW, 980nm laser is generated from this source. The temperature of the diode is monitored and controlled through an integrated TEC (thermoelectric cooling unit) element.

	FiberPort Collimator
	2
	Aligns photon rays in a single unified direction.  After exiting the collimator, the laser beam is focused and extremely dangerous. 
Do not remove covering without supervision.

	Relay Lenses and
Beam Steering
Mirrors
	3A, 3B, 4, 8
	Relay lenses and dichroic mirrors are required to direct the collimated laser beam into the back aperture of the microscope focusing objective and imaging detector of the CCD camera.

	CCD Imaging
	5
	The charge coupled device camera is used to image the sample. Images can be viewed through the uc480viewer software.

	Piezo Sample Stage
	7
	Consists of a microscope slide holder mounted to a 3-axis translation stage. The Stage is capable of movement in the x, y, and z directions and contains both coarse and fine knobs to ensure accurate sample positioning.

	Position Sensing Detector
	10
	The signal generated by the Quadrant Position Detector (QPD) is sensitive to the relative displacement of a trapped particle from the laser beam axis.  As a result, the QPD is used to measure the positon, stiffness, and force of the optical trap.




4. Pre-lab Exercises 
1. Using the schematic provided, describe the path of the laser leading up to the sample.
2. Estimate the amount of 1-micrometer beads in micrograms that you will need to prepare a 10- microliter sample of distilled water with suspended beads separated by about 10 micrometers on average. Record your result. This concentration is suitable for initially observing and practicing trapping. For actual measurements of a single trapped bead, a much, much lower concentration is needed to avoid having multiple beads trapped at the same time.
3. Create a folder with your name in the T-folder of the computer to store your data.
4. 

5. Laser SafetyFigure 5 

5.1 – Laser Characteristics
The laser diode used by the optical tweezers system has a maximum power output of 330mW emits light at a wavelength of 980nm, which is in the infrared range. It employs a collimated beam and is classified as a Class 3B laser. A Class 3B laser is considered hazardous under direct and specular reflections, and direct exposure to the eye is considered a hazard. Through the inclusion of safety interlocks to enclose the open beam region, the system has been re-classified as a Class 1 working environment. 
5.2 – Hazards
1. Stray beams: Diffuse reflections can occur if objects are placed in the path of the beam, which is especially dangerous since the positon of the invisible light is unknown. Do not place your hands or any object in the path of the laser at any time to avoid such reflections. 
2. Beam Alignment: This is an extremely dangerous procedure since it involves working with an open beam. Please contact the supervising Professor if you believe a beam alignment must be performed. NEVER tamper with the safety cover enclosing the open beam region [18]. 
3. Biological Hazards: Eye injuries could occur if direct exposure to the focused laser beam occurs without the laser safety glasses. The laser used in this set-up falls within the Retinal Hazard Region, and can result in retinal burns, scars, overheating, blind spots or even permanent loss of central or peripheral vision. Due to the invisibility of the light, you may not be aware of the damage until after it occurs. 
The open-beam region has been enclosed for your safety. Please follow the safety procedures outlined below. 
5.3 – Hazards Control
Before beginning the experiment:
1. Obtain the interlock key from the Advanced Physics Lab Technologists.
2. Remove any wristwatches or reflective jewellery. 
3. Remove any unnecessary items from the apparatus table. 
4. Wear laser safety glasses AT ALL TIMES. Check the wavelength and the optical density to ensure these are appropriate.
5. Remember to turn off the laser when changing samples.
6. In case of emergency, contact your TA/Instructor or UofT Campus Police: 416-978-2222. If an eye injury occurs, see an ophthalmologist. 
[bookmark: _Ref506478199]6. Experimental Procedure
Optical traps operate best when the trapping laser wavelength and the diameter of the trapped bead are comparable. In this regime, neither of the two approximations are valid and theories regarding trapping in this regime are very complex [16]. Thus, the stiffness of traps within this regime cannot be accurately predicted. Given the fact that different beads and power of the laser will often be required during experiments, empirical methods of determining the stiffness of an optical trap is crucial. The calibration experiments outlined in this lab will take you through a variety of methods to determine the trap stiffness. The numerous sub-experiments outlined will demonstrate a variety of methods to determine the trap stiffness.
6.1 – Equipartition through CCD Camera
The Equipartition theorem will be employed for a trapped bead undergoing thermal fluctuations in order to determine trap stiffness.
For each degree of freedom in the thermal motion of the particle, there will be ½k BT of thermal energy, where kB is the Boltzmann constant and T is the temperature in Kelvin. When the bead is not trapped, the thermal energy is converted into kinetic energy and the bead will undergo random walk in the medium. If the bead is in a harmonic trap, the thermal energies become potential energies manifested in a small displacement. Over large sample sizes the fluctuations will give the result:
                                    (6)
where <x2> is the variance of the x displacements, and k is stiffness. In this experiment, you will be recording and analyzing the .avi videos from the CCD camera to find this quantity and calculate stiffness. It is important to note that precision of the positional data is critical for this method. Since the fluctuations in positon are squared, it is highly sensitive to noise. 

6.2 – Experimental Operating Procedure
6.2.1 – Sample Preparation(a)                                                        (b)


Figure 6: a) Components of the sample slide: microscope slide, two strips of double-sided tape, and a cover slip. B) Student trimming off the excess tape from the sample slide with a razor blade.
1. The tools and materials you will use are shown in Fig. 7(a): Kimwipes (1); vacuum grease (2); syringe (3); razor blade (4); pipette tips (5); micro-pipette (6); possible biological tissues for optional experiment (7, 14); microscope slide (8); cover slip (9); garbage for slides (10); double-sided tape (11); glass container for solution with beads (12); beads (13);  gloves (14); ethanol (15); distilled water (17); saline solution for conservation of biological tissues (18). Work in gloves!
2. Clean both sides of the microscope slide with ethanol and Kimwipes and ensure that it is kept clean. Dirt or oil can affect the measurements as it may cause scattering of the beam [18].
3. Place two pieces of double-sided tape separated by about 3-4 mm across the centre of the slide. Place another layer of double-sided tape on the first layer. This creates a channel with sufficient height that the beads can move through. Press on the tape to eliminate air bubbles near the channel to ensure that the liquid will not escape the channel. 
4. Clean the coverslip with ethanol and Kimwipes and place it on top of the channel and the double-sided tape strips, which will hold it in place. Centre the cover slip such that it is not at the edge of the glass slide. Press on the tape contact to ensure that the liquid cannot escape from the channel, and carefully trim of the excess tape from the ends using a razor blade.
5. Adding the sample:
a. In a clean unused container, prepare a high-concentration solution of 1-μm beads in distilled water with concentration as calculated in the prelab exercises. Shake the sample solution thoroughly to evenly distribute the beads. Once the sample is created it may be used for 24 hours.
b. Using the micro-pupate and the appropriate plastic tip, pipette the sample up and down several times to mix the solution and obtain 10 µL of the bead solution and insert it into the channel from one end just outside of the cover slip. The bead solution will fill the channel through capillary action and gravity. 
6. Discard the plastic tip into the garbage bin.
7. Seal the open ends of the channel using vacuum grease and carefully recap the syringe. 
8. Before loading the sample, place a drop of Immersion oil on the Nikon oil Immersion objective lens (Fig. 7b). 
9. To load the sample, use the translating breadboard to positon the sample holder between the objective and condenser (Figure 7, A) with the cover slip facing down. 
(a)                                       (b)












Figure 7: (a) Tools and materials required for sample preparation. 
                (b) Position of the sample between the Nikon objective lens and condenser. 
Note: 
· The beads in the channel should be somewhat scarce, so as to allow isolation and trapping. 
· It is recommended that you use two bead concentrations during the course of the experiment – a higher concentration to practice trapping and a lower concentration for actual measurements. 
· The entre stage can be translated along the direction perpendicular to the beam path to facilitate loading and unloading of the sample. 
WARNING: Please turn OFF the laser when changing samples.
6.2.2 – Camera Settings and calibration
The CCD camera is controlled through the uc480viewer software. Before beginning, turn on the LED light to illuminate the sample by powering the LED (connect wire from the LED on top of the apparatus to the wire labelled “LED Power”). 
1. Place a sample with beads onto the stage. 
2. Start uc480viewer. Press the Open Camera button to display the live image. 
3. Find z-position of the stage that permits clearly observing the beads.
4. Without changing the stage position, replace your sample by the Micro Line and Dot Standard Stage Micrometer to find a conversion from pixels to micrometers for an object on the microscope slide that you observe in the viewer. For better accuracy, it is recommended to use a number of standard dots and lines. Record your result. Remove the standard from the stage.
 
6.2.3 – Powering the Trapping Laser
Contact your TA/Instructor before turning on the laser to ensure that all the safety precautions have been accounted for.
Please wear laser safety goggles AT ALL TIMES while the laser is on. 
[image: ]
Figure 8: ITC 510 Laser Diode Combi Controller.
Insert the laser key into the Mains Control Switch on the ITC 510 Laser Diode Combi Controller and turn it to the ON positon. 
Temperature Controller
Using the display selection keys:
1. Ensure that TH < 20 kΩ is selected under the Sensor Selection keys.  
2. Check that TACT is around 10.5 kΩ. This should already be set. 
3. Select TSET and set the value to about 10 kΩ using the Main Dial TEC. The TEC, when set properly and 'enabled', will control the temperature of the laser diode, which prevents temperature related power fluctuations. It should not need to be adjusted. 
4. Power on the TEC.
Current Source
The laser diode is powered through the Laser Diode Controller (LDC) upon setting and enabling the TEC.
1. Select ILD LIM and ensure that it is set to around 350 mA.
2. Select ILD and set it to 0mA using the Main Dial LDC. 
3. Power on the Laser. 
4. Turn the Main Dial LDC to adjust the power of the trapping laser (this adjusts the ILD). 
5. Before the next exercise, turn the laser current to about 50 mA.

6.2.4 – Obtaining the value of the beam power as a function of the laser current
1. Connect a Microscope Slide Thermal Power Sensor to the PM100D Power Meter Console and plug in the AC adapter of the Console into the net. 
2. Exercise with the power meter using the provided manual to learn how to read the meter. 
3. Carefully place the sensor head on the stage at the position of a microscope slide. The size of the sensor head fits the stage dimensions. 
4. Read the power meter for 50 mA. It is expected that the power is zero. Prepare a table for measurements power vs. current for the range of current between 50 mA and 350 mA.
5. Create a diagram for the calibration power vs. current. 

6.2.5 – Viewing the Beads
1. Replace the power sensor head by a microscope slide with 1-μm beads and greater concentration of the beads with the cover glass down. You may need to add immersion oil between the cover glass and the objective lens.
2. Set ILD to 100 mA (laser diode current). 
3. Use small adjustments to move the Nikon objective upwards using the Z micrometer until you see the beads. 
4. Use the X and Y micrometers (coarse and differential knows) to view the channel and adjust the brightness of the camera as necessary to improve visibility of the beads. 
6.2.6 – Trapping a Bead and Calculating Stiffness Using the Equipartition Theorem
1. For initial trapping of a bead, a sample with lower concentration of the beads and a current of about 350 mA are required. 
2. To find the trapping positon, scan the beam in the X and Y directions using the coarse and differential knobs. When a bead is near the trap axis, it will either be captured by the trap or be shot out of the field of view due to the scattering force. 
3. If you are having trouble trapping, gradually move the sample higher such that the focus is closer to the coverslip.
4. Once you are comfortable trapping beads, switch to slide with a much lower concentration of beads for precision trapping of a single bead. If more than a few beads are visible at a time, it is very difficult to avoid trapping multiple beads.
5. Once you have trapped a bead, record a video sequence through the uc480viewer software in the following steps: 
a. Once the bead is trapped, crop the image by accessing the Size tab and changing both Width and Height to 120 pixels and adjusting Lef and Top accordingly to capture the trapped bead in the field of view.
b. To record a video using the CCD camera, go to File  Record video sequence and press the Create button. Set the file path, change the JPEG Quality to 100 and Max Frames to 100-500 (begin with 100 and find the best number of frames in several trials), then press Record. The data will be saved in .avi format. A greater number of frames improves the accuracy of stiffness calculation, but also increases the time needed to process the data.
6. Open the ImageJ program in the Start Menu. You will convert the *.avi file into the *.tif file.
7. In the window of ImageJ: File -> Open file -> (browse the created video *.avi file) -> Image -> Type -> 8-bit -> Image -> Adjust -> Brightness/Contrast (if required) -> File -> Save As -> Tiff. The *.tif file will contain your video as a set of frames. Pay attention to the number of frames, as this number will be used for the data analysis with Python.
8. Open OpticalTrapVideoAnalysis.py in the Start Menu. Click Run.
9. [image: C:\Users\user\AppData\Local\Microsoft\Windows\INetCacheContent.Word\Python window 1.jpg]In the appeared window 
(a) set the proper number of frames, from 0 to any one that is smaller than the actual number of frames in your saved file. The default setting is 100 frames, which will work if the actual number of frames is greater than 100.
(b) At the upper left corner of this window browse the *.tif file you have created.
(c) Set the spot size and maximum displacement in pixels or try to use the default settings. You may safe frames, but usually it is not required, and you should select Display Frames, because you have already saved the file with frames.
(d) Enter the temperature as a parameter that effects stiffness. The default setting is 293.15 C.
(e) Click “Start Analyzing”.
10. In the popup, use cursor to click on the centre of the bead. You will see a black dot.
11. With a cursor move from left to right, going from frame # 0 to the end of the strip. You have set the maximum number of frames earlier.                        (a)                                                                                             (b)
Figure 8. Result of analyzing the trapped bead by the Python program.


12. Wait for about 1 -2 minutes (depends on the number of frames) and close the popup. The following three outcomes will appear: a 3-dimensional track of the bead entitled Figure 1 (Fig. 8a);  x-, y- and radial displacements of the bead entitled Figure 2 (Fig. 8b) and a *.txt file with the data shown in Figure 2. This file can be used for future calculation of stiffness using a different program of yours.
13. The program returns the mean-square values of x-, y- and radial displacement. Use these data for stiffness calculation. All files are saved by default in the folder Optical_Trap_files. Copy the results to the USB and your personal folder created by you in the T-folder of the computer.

 Perform this experiment for the beads of different diameter. The beads are stored in MP 250.
Compare the results to the ones reported in the article "Optical tweezers for undergraduates: Theoretical analysis and experiments" by M.S. Rocha (2009) in The American Journal of Physics.
Discuss possible discrepancies with the published results and uncertainties of your measurements.
6.3 – After Completing the Experiment
1. Ensure that the laser is OFF before removing your laser safety glasses.
2. Power off the TEC. 
3. Remove the key from the laser controller and return it to Rob. 
4. Dispose the slides in a glass disposal box. The pipette tips and kim wipes can be put into the regular trash. 
7. Defining the Trap Stiffness with Quadrant Detector
In this experiment, you will need a properly centered QPD. The coarse indicator is a centered green light in the lowest controller cube. The NanoMax MAX311 piezo transition stage allows nanometric movements of the sample in two dimensions using piezo actuators. The stage is controlled through a T-Cube controller on the THORLABS T-Cube USB Controller Hub. The step-by-step instruction for using the LabView software to calibrate the QPD and to collect and analyze data is given in the Thorlabs Back Focal Plane Detection Module User Guide. 
8. Post-lab Questions
1. Comment on the differences for varying bead diameters and its effect on the respective trap stiffness.
2. Discuss the advantages of using the Quadrant Detector for data collection versus the CCD method.
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[bookmark: _Ref506478363]Appendix I –  Thorlabs’ Manuals:
· OTKB - Optical Tweezers Kit User Guide
· OTKBFM - Back Focal Plane Detection Module User Guide
· PM100D - Optical Power and Energy Meter Operations Manual
· ITC510 - Laser Diode Combi Controller
· 19590-M01 - Optical Trap Application Setup    (Original Thorlabs guide when this experiment was developed.)
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74 Optical Trap Video Analysis

Enter information for video to be analyzed:

Open a TIFF file:[T5/Optical_Trap_fles/ TrappedBeaci it Bowse|  FleType 8t —|  Surtfamelo Stop frame: o

Enter the parameters for the grid used to initilize motion tracking and the properties of the spot:
Spot size (radiusin px): [1 Mox displacement (px): 5 Minimum net brightness 0-255): [150

Enter the information for saving or displaying the frames of a racked video:
I™ Saveframes 7 Display frames Directory to save to: [Only necessary if Save frames' or Display frames' is selected  Browse

Enter the variables for trap analysis:
Temperature (K): 2315

Start Analyzing

Dialog: »>> Enter all required information above and click Start Analyzing’
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